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The SciCord Solution 
The SciCord solution is comprised of two parts, the SciCord Portal, and the SciCord Client.  

• SciCord Portal is designed for specific users to configure the system, by conducting 

administrative duties (ex. role assignment, reporting, configurations, etc.)  

• SciCord Client is designed for scientists, supervisors, and QA personnel to go through the 

workflow process of creating documents and/or objects, recording data, reviewing, and 

completing documents. There is a system of checks and balances between users that record 

information into documents, and users that review, approve, and complete documents.  

Together the SciCord solution and the customer maintain the integrity demanded of a compliant 

environment. 

 

U.S. F.D.A. 21 CFR Part 11  
 

The SciCord Solution represents a ‘Closed System’ providing 

compliancy to U.S. F.D.A. 21 CFR Part 11.  

Part 11 applies in one of the following situations: 

• When electronic records are used instead of paper. 

• When people create printouts but still rely on the 

electronic records in the computerized system to perform regulated activities. 

• Records submitted to the FDA, under predicate rules (even if such records are not specifically 

identified in agency regulations) in electronic format. 

• Electronic signatures intended to be the equivalent of handwritten signatures, initials and other 

general signings required by predicate rules. 
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SciCord Client  
The SciCord Client is initially accessed through the SciCord Applications/Client Installer section of the 

SciCord Portal. The user must have the Auth_WebUILogin permission to access the SciCord Portal and 

the Auth_ClientLogin permission to access the SciCord Client. The Permissions granted in the SciCord 

Portal allow a user further access based on their roles assigned in the SciCord Client. The permissions 

grant access to certain Documents, Objects, and Resource entity functions. 

The SciCord Client is a rich internet application. It can create Documents, Objects, and Resources based 

on specific Templates where the user may record experimental data or Object management 

information. These entities can go through a workflow process from Created to Complete with various 

steps in between.  

Versioning and Hosting 
The SciCord Client provides visibility of the environment in the title bar. A user can access the full 

versioning information via the ‘About SciCord’ option in the drop-list of the ‘Settings’. 

 

 

 

 

 

 

 

System Configuration and Customization 
The SciCord Solution allows administrators to create and configure via the SciCord Portal ‘system 

parameters’, which the SciCord Client can use to implement specific Business Logic. Examples include: 

• Provide a system configuration defining a default list of "Audit Reasons".  

• Provide a system configuration to define whether "Audit Reasons" are mandatory.  
• Provide a system configuration to define "default Review classification" automatically   

assigned to a new document. 

 

 

 

• Product Name:  <SciCord Client> 
• Version: <Ver> 
• WebApi version: <Api Ver> 
• TemplateApi version: <TemplateApi Ver> 
• Database version: <Database Ver> 
• Environment: <Environment Name & Business version> 
• Licensed to: <License> 
• Memory used by process: mb 
• Loaded Modules: lab equipment modules for equipment 

integration 
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Installation 
Note: The User must have access to the SciCord Portal to begin the SciCord Client Installation Process. 

 

The SciCord Applications, SciCord Client Installer can be easily installed. The direction for installation: 

• The SciCord Client Installer will download an executable file onto your local machine. 

Once downloaded, the user may open the file where the installer file will automatically 

place an icon for the SciCord Client on your desktop, and open to the login screen. The 

name of the desktop shortcut will be ‘SciCord Client’.  

 *This is the easiest and best option for most users.  

 

Silo Environment Login 

 

✓ Enter password 

SciCord 
Client 
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✓ Click OK 

SciCord Multitenancy Login Screen 

 

 A Multitenancy user will have a selection dialog appear. The user will need to:  

✓ Select target environment 

✓ “Remember” checkbox (system will automatically remember your target environment) 

✓ Click OK 
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SciCord Client: Home Screen 

Home Screen 

Once the User has logged into the SciCord Client, it will open to the “Home” screen.   

There are two visible panels in the SciCord Client Home screen:  

• Navigation Pane in the upper left  

• Home Pane selected is the large section on the right. Greeting appears along with recent 

entities (if any) that have been recently opened by the user.  

o Recent Documents, Recent Objects, and Search tabs are present with a full text search 

bar, a drop list for Document, Object, Resource, and a Help button. 

 

  

A unique feature is that the User may re-size each of the panes by selecting the border and dragging it 

to the desired location. 

 

*See the SciCord Icons and Meanings section for a description of each of the icons. 
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SciCord Client: Home Functions 

Standard Functions 
There are shortcut functions that appear at the top of the Client’s Home screen regardless of which 

View the user has selected. By hovering over each of the functions the user will observe a dialogue 

(tooltip) that states what each shortcut function does.             

 

From left to right the Functions are:         

• Home: one click navigation to the Home dashboard 

• Quick Search Bar: once typing begins a drop list allows the user to select an entity to search for 

and enter in any numeric or text search for: 

o Document 

o Object 

o Resource  

• Create a new Document: one click option to open New Document dialog  

• Create New Object: one click option to open New Object dialog 

• My Calendar: one click to open users Work Request schedule 

• SciCord Portal: one click navigation to open the SciCord Portal 

• Settings: a drop-list that allows a user to select  

o Change Password 

o Active Content Link  

o Registry Script 

• Help 

o Feedback 

o Help – will download the SciCord User Guide 

o About SciCord  

• Memory Usage Gauge: color coded system usage shown in mb 

• Minimize, Maximize screen  

• Logout Icon: An error message will appear if any open entities need to be closed prior to 

logging out. 

• X: used to close the Home view panels current page (directly below the logout icon) 
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• ^: used to collapse the Home ribbon 

Home Dashboard 
Upon login the user is greeted and can quickly look up any recently opened documents, objects, or 

search from a full text search bar. 

 

Search  

Full text search bar allows for a quick search of All, Documents, Objects, Resources and Files using 

the tabs on the search page. A Help button  is present to assist the user using strings with the 
following examples:  

 

A check box for “Only my site” is checked by default  
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A filtered search can also be performed using the drop list at the end of the search bar. 

 

A right or left click at the “…” reveals a dialog box to select an action: 

• Open for Edit 
• Open for Read Only  

• Open for Review 
• Open Status Dialog 
• Clone 

Once the action is selected the system will navigate the user to the selection. 

 

User may clear searches by right click of Recent Searches 
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‘Home’ Pane 
Upon login, the user is greeted and shown a list of Recent Documents, Recent Objects, and Search 

accessed.  

  

Welcome Screen Home View 



 

SciCord Client User Guide – Boron v3.0  
May 2024 

 

Page 14 of 94 

Shown here is a close up of the Home ribbon tab functions on the Welcome screen. The Home tab is 

divided into 3 sections: Entities, User, and Other 

 

• Entities: allows for creation of New Document and New Object. 

• User:  

o SciCord Portal one click access to the SciCord Portal login 

o Schedule: opens the users work request schedule 

o Settings: functions include: 

▪ Change Password - dialogue to change password 

▪ Active Content Link- connects users’ phone to the Client. Use it as a Barcode 

scanner or send images (Available in 2.1 or newer version)  

▪ Registry Script – loads SciCord Client registry script 

▪  Help – downloads the SciCord User Guide 

▪ Feedback – send feedback  

▪ About SciCord – version information for SciCord Client 

• Other:  will open a dialog that allows for creation of New Data File, New Specification, New 

Message 

SciCord Client: Tabs 

Home Tab 
Home tab will vary depending on the type of view that the user has accessed. The Home tabs are 

grouped and divided into sections with icons and tool tips to guide the user to complete tasks.  

See Documents view example below: 

 

* The Manage and View sections of the Home tab are consistent for all views. 
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Options Tab 
The Views Pane allows the user to quickly access from a list of views that the user may choose to 

include in their views list. Each of the pre-defined views are unique with their own filtering capabilities.  

Tip: The User may add multiple versions of the same View and rename them if they choose; this may be 

beneficial to the user if they would like to filter each of the views differently. 

Filters: In the Options tab the user can reveal a hidden pane that is on the right of the SciCord Client 

screen. To access the Filters and Columns function navigate to:  

 

• Options tab in upper toolbar 

• Hide is used to close the Filters, Columns, and Scheduling pane. 

• Filters and Columns icons are present may be used to sort and present data that is relevant to 

the User. The Default columns included on each specific ‘View’ pane vary depending on which 

View is selected. Below is an example image (from the Documents View) of the Filters and 

Columns that a User may choose to include in their various Views.  

  

Filters View      Columns View  
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• Dialogs and/or drop lists will prompt the user for criteria to set for Filters. A slider can be used 

for date criteria as well as a text box for numerical entry 

• Checkboxes are used to set criteria for Column filtering 

• Green ‘+’ symbol the user may add one or multiple filters 

• Red ‘---’ symbol the user may remove one or more filters  

Once the filters are set, the user may sort by selecting the Column header in the specific ‘View’ pane, 

which will order the data either ascending or descending. Example below:  

*Denoted by the downward arrow in the Date column, to display it is sorted in descending order. An 

upward facing arrow denotes ascending order.  

 

 

 

• Scheduling used to create recurring reports that will 

be sent to logged in user email. Click the dots “…” 

next to “Schedule”; a dialog with drop list for the 

Cron Expression will appear to make schedule 

selection. 
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Navigation Pane  
There are six options available within the Navigation pane. Every user is allowed access to these six 

functions. Hovering the mouse over each icon will reveal a tool tip description of each item.  

• Home: one click navigation to the Home dashboard 

• Refresh: Reloads Navigation data (pinned items and directories) from the server. 

• Add Directory: Creates a new directory in the “Directories” section of the Navigation Pane 

• Add View: Drop list options used to create and add new views to the “My Views” section of the 

Navigation Pane. Available views:  

o Documents 

o Data Files 

o Groups 

o Objects 

o Object Inventory 

Requests 

o Messages 

o Reports 

o Objects Results 

o Objects 

o Sent Messages 

o Specifications 

o Equipment  

o Samples 

o Object Work Requests 

o Templates 

o Users 

o My Approve 

o My Documents 

o My Samples 

o My Data Files 

o My Reports 

o My Review 

o My Objects 

o My Templates 

o My Users 

o My Equipment 

 

 

• Rename: Renames the selected entity. 

• Delete: Deletes the selected entity. 

• ^: used to collapse the Navigation ribbon 

Trees Section 
There are six sections, or “Trees”, displayed within the Navigation Pane. 

• Home: One click navigation to the Home dashboard 

• Pinned: Pinned favorites, further delineates among: Documents, Objects, DataFiles, and Directories. 

• Recent: A list of recently accessed documents or entities. 

• Directories: A fully customizable directory structure used to store subfolders, documents, and 

entities in the desired tree hierarchy. 

• My Views: The main section utilized for navigating between views, which can be customized by 

adding any combination of the aforemented 26 available view choices. 

• Open Sessions: This section displays any currently opened documents or entities. 
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Within the trees section, a user can Right Click any entity to access the following options: 

• Open: Allows a user to open an entity for Edit, Read Only, Review, or Status. 

• Add New: Option only available to subfolders within directories. 

• Clone: Allows a user to clone a document or entity. 

• Delete: Allows a user to delete a view or subfolder within a directory. 

• Rename: Allows a user to rename a document 

• Add to Directories: Allows a user to link an entity to a defined directory 

• Pin: Pins any entity or directory to the “Pinned” section of the Navigation Pane 

• UnPin: UnPins any entity or directory from the “Pinned” section of the Navigation Pane 

• Copy Reference: Copies the reference to any entity 

Messages View 
Below is an image of the functions associated with the Messages View. There are three sections: Message, 

Manage, View. 

 

In the Message section, from left to right the functions are: 

• New Message – a dialogue that allows a 

user to send a Message (Subject and Body) 

to users with access to the SciCord Client. 

Once typing begins, a selection of system 

users appears in the Recipients field to 

Add to the message. 

 

 

 

 

• Read Message – The user is allowed to 

Read the Message that has been selected. 
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• Dismiss - The user can ‘Dismiss’ or mark as done on the Read Message dialogue or they can select 

the Dismiss icon as seen above in the Messages Functions ribbon. 

*Tip: The User may change their mail preferences by using the Options tab Filters. 

 

Messages default Filters and Columns 

*The Manage and View sections of the Home tab are consistent for all views. 

• Duplicate – create a copy of the view 

• Rename – user can rename the message view 

• Export View – allows the User to Save as an Excel file the Messages View 

• Delete – removes the messages view 

• Refresh – allows the View page to be refreshed 

• Fetch All – shows the number of Messages included in the Messages View. If there are no Messages, 

then this will appear as ‘0/0’. 

 

Documents View 
The Documents View lists all the Documents in the SciCord Client.   

Icon and Lock column appear in the Documents View. The icon meanings are described: 

 

 

 

 

 

Icon Meaning

 Created Status 

 Cancelled Status 

 Rework Requested Status 

 
In Progress Status 

 
Review Assigned Status 

 Approve Assigned Status 

 Complete Status 
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In the Lock column, the  will appear if the Document is currently in use by another user.  

If a user chooses to unlock the document, then a dialogue will 

appear: 

 

*Only users with Document_Unlock permission can perform this 

action. 

 

 

 

 

Document view illustrating Documents view Lock icon 

 

The Home tab Documents view functions (from left to right) are: 
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*Hover the mouse over each icon to view the tool tip for each. 

• New: Document_Edit permission required 

• View: Document_View permission; opens document with a ribbon stating: 

o “READ ONLY VIEW Changes to the document will not be persisted.” 

• Edit: Document_Edit permission required 

• Rename: Document_Edit permission required; renames selected document. 

• Clone: Document_Clone permission; clones selected document. 

• Review: Document_Review permission required; user is assigned to Review the Document 

• Status: Document Status Update permissions required.  

• Unlock: Document_Unlock permission required. 

• Message: Create a message for the selected document. 

• Download: Downloads the document. 

• Attachments: Downloads document attachments. 

 

*The Tags, Manage and View sections of the Home tab are consistent for all views. 

 

• Add: Links a tag to the document. 

• Set: Replaces tags linked to the document. 

• Remove: Removes tags linked to the document. 

• Duplicate: Creates a copy of this view. 

• Rename: Renames the Document view. 

• Export: Allows the User to Save as an Excel File the Documents View. 

• Delete: Deletes the Document view currently displayed. 

• Refresh: Refreshes the Documents List. 

• Fetch All: Shows the current number of documents being displayed/ the total count of documents 

available. 

The Options tab Documents view functions (from left to right) are: 
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*Hover the mouse over each icon to view the tool tip for each. 

• Hide: Using this icon will close the filters/columns display. 

• Filters: Filter data to locate or narrow to locate an entity. 

• Columns: Checkboxes used to reveal columns to be shown in entity view. 

• Scheduling: Schedule periodic extractions. 

• Pin: Using this icon will pin the selected document to the “Pinned” section of the Navigation Pane. 

• Add: This icon will add the selected document to the “MyViews” section of the Navigation Pane. 

• Add to Directories: This icon will add the selected document to a desired directory within the 

“Directories” section of the Navigation Pane. The specific directory destination will be defined in a 

secondary dialog that pops up after the icon is clicked. 

• Add Groups: Add the selected Document(s) to one or more Groups. 

• Remove Groups: Remove the selected Document(s) to one or more Groups. 

The user may add any Filter to the View and any additional column. 

DataFiles View 
The SciCord Client supports the storage of generic files, called ‘Data Files’ throughout the system. Data Files 

may be uploaded to the system using the SciCord Client or the SciCord Portal. Once a Data File is added to 

the system it can be used as an attachment in any document and may be shared with other users. 

 

 

The Icons present in the Data Files view are from left to right: 
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• Upload: DataFile_Create permission required; A dialogue will appear allowing the user to Upload a 

File, Set Tags, and provide any Notes 

• Properties: DataFile_Edit permission required; user may change the File Name, Folder, Description, 

Tags, and Notes of a Data File 

• Delete: DataFile_Delete permission required; User may Delete any Data File from the System 

• View: view the data file 

• Download: The User may Download the Data File  

• Signatures: view and manage the electronic signatures 

• History: will open the history for this file 

• Add to Directories: This icon will add the selected data file to a desired directory within the 

“Directories” section of the Navigation Pane. The specific directory destination will be defined in a 

secondary dialog that pops up after the icon is clicked. 

 

*The Tags, Manage and View sections of the Home tab are consistent for all views. 

Below are the Filter and Column choices provided to the User for sorting Data Files and presenting 

information that is relevant to the User. 
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Filters View      Columns View 

 

Groups View 

The user can define and manage ‘Groups’ for the purpose of assigning and filtering entities. Groups 

are defined in the SciCord Portal by an Administrator, and include the Group Name, a Description, 

Active flag, and Customer flag. 

In the SciCord Client, Users will be able to add, or remove, Documents to all Groups that they are a 

member of. The user will not be allowed to add, or remove, any Documents to Groups that they 

are not a member of. 

The Groups View shows to the user which Groups that they are a member of. 
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The Icons that are associated with the Groups View Options are, from left to right: 

 

  

 

*The action items listed in Groups view; Home and Options tab, Manage, View, and Options sections are 

consistent for all views 

Below are images of the Filters and Columns available to the User in the Groups View: 

 

Filters View     Columns View 
 

MyApprove View 
The MyApprove View is a special implementation of a Documents view. This view displays Documents in 

‘ApproveAssigned’ status only, where the assigned approver is the current active User.  

A user that is assigned approver of a document, meaning in ‘ApproveAssigned’ status, the document will 

appear in the ‘MyApprove’ View. 
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*Although many of these icons are viewable, only a few are selectable depending on the users’ actions and 

set permissions  

Below are the Filters and Columns that a user may use to sort and display the details of the MyApprove 

View. 

  

                                           Filters View          Columns View 

Bookmarking Functions 
These functions allow a user to create a saved shortcut list for the logged user. These features are present in 

the Options tab as “Pin” and “Add”. 

The “Add” button will add the selected entity to the ‘My’ view. (ex: My DataFiles,), and is available for the 

following entities:  

• Documents 

• Samples 

• Objects 

• Data Files 

• Equipment 

• Templates 

• Users 

• Reports 

• Review 

• Approve 
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The “Pin” button will add the selected entity to the “Pinned” section of the Navigation Pane., and is 

available for the following entities:  

• Documents 

• Samples 

• Objects 

• Data Files 

• Equipment 

• Review 

• Approve 

 

Toolbar view 

  

Contextual view 
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MyDocuments View 

The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Documents 

that have either been created by the user, or that they decided to include in their MyDocuments 

View by using the Bookmark function. 

 

 

Below are the icons associated with the Home and Options tab MyDocuments View 

 

 

  

*The Home and Options tab icons available are consistent for Document and MyDocuments views.  

Below are images of the default Filter and Column settings that a user may use to sort and display the 

details of the MyDocuments view. 
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Filters View    Columns View 

 

MyDataFiles View 

The ‘My’ View is a bookmarking functionality. Using the MyDataFiles function the user can include the 

generic DataFiles into their ‘My’ View.  

The Bookmark/Add icon appears in the Options tab DataFiles toolbar, or the user can right-click on any Data 

File and an option to Bookmark will be available. 

MyReview View 

The MyReview view is a special implementation of a Documents View. This view displays documents in 

ReviewAssigned status only, where the assigned reviewer is the current active user. 

The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Documents assigned 

to them for review. 
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The Icons in the MyReview View toolbar can be seen below: 

 

 

 

Important Icons are the ‘Open Document for Review’, the ‘Modify Document Status’, and potentially the 

‘Create a message for the selected Document’. These icons allow the Reviewer to: 

• open the Document to complete Review 

• to modify the Status 

• and to write a message to the Users involved with the Document 

Below are the Filters and Columns available for selection in the MyReview View: 
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Filters View      Columns View 

My Reports View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Reports that have 

either been created by the user, or that they decided to include in their MyReports View. 

By using the Bookmark function the user can include Reports into their ‘My’ View. The Bookmark icon 

appears in the Reports toolbar, or the user can right-click on any Reports in the Reports View and an option 

to Bookmark will be available for selection. 

*The action items listed in MyReports view; the Home and Options tab, Manage, View, and Options 

sections are consistent for all views 
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Home toolbar, Reports section, functions:  

• Manage Reports: action will open the SciCord Portal Reports Index page 

• Details: action will open the SciCord Portal Report Details page to show Report Name, Report Type, 

Description, Report File – Launch option, Rdlc Name, Report File Name, Report File Version, Status, 

Is Admin checkbox, and Version information. 
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• Launch: action will open the SciCord Portal 

Report Configuration details with fields for 

Date From, Date To, drop list for Category, 

drop list for Site, Show button, Report File 

Name, Report File Version, Report File 

Upload Date, and Report File Uploader.  

 

 

 

 

 

 

 

The Filters and Columns for MyReports Views are displayed here:  

 

Filter view   Columns view 

 

MyObjects View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Objects that have 

either been created by the user, or that they decided to include in their MyObjects View. 

By using the ‘Add to MyObjects’ function the user can include Objects into their ‘My’ View. The ‘Add to 

MyObjects’ icon appears in the Objects toolbar, or the user can right-click on any Object in the Objects View 

and an option to ‘Add to MyObjects’ will be available for selection 
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MyObjects view 

  

MyObjects contextual view menu options 
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Below are the icons present in the MyObjects and My Objects View: 

 

From the MyObjects/My Objects Toolbar the User can navigate to different tabs and options:  

Object:  

• New – action to create a new Object 

• View – action to view a selected Object 

• Edit- action to open Object for edit 

• Clone – action to clone the selected Object 

• Review – if the user is assigned as Object reviewer, this action is enabled 

• External – opens the object external reference 

• CAS – opens the CAS registry URL 

• Status – action to modify the Object status 

• References – lists object references 

• Label -- print labels for selected objects or Objects 

• Message – send a message 

• Attachments – view attachment for selected Object or object 

Specs: 

• Specification Details with options to Save, Add, Close, Refresh, and Export. User will also have the 

option to Toggle the details of multiple Specification 

Work Requests:  

• Work Request Details - with options to Save, Add, Close, Refresh, Export, View and Edit 

(dependent upon ObjectWorkRequest_Edit permission or the ObjectWorkRequest_Edit permission 

) Object 

• Work Request Schedule – displays a calendar view of Work Requests for selected Object or Object 
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Inventory: 

• Inventory Details - Home and Tools tab view with options to Close, Refresh, Toggle, Export 

Transactions and Requests 

• Inventory Schedule – Calendar view of Inventory Transactions 

*The action items listed in MyObjects or My Objects view; Home tab, Manage and View sections are 

consistent for all views  

Options tab functions: The user may also Pin Objects to the Pinned section and Remove Objects from the 

MyObjects view. Add to directories can be used to add the object to a defined directory, and Add/Remove 

Groups can be used to add/remove the object to a defined group. 

Below are the Filters and Columns that may be selected by the user to sort and display MyObject or 

MyObject Details: 

  

Filters View     Columns View  

MyTemplates View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Templates that the 

user decides to include in their MyTemplates View. 

The user can go to Options tab, Bookmarks Add or, right-click on any Template in the Template View and an 

option to Bookmark will be available to add the selection to MyTemplates view. 
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The MyTemplates Toolbar: 

• View (Help) – if a Help document is associated to a template this action will open the document 

• Duplicate – Create a copy of this view 

• Rename – Rename the templates view shown in the Views pane 

• Export – export the MyTemplates view as an excel worksheet  

• Delete – action to delete the MyTemplates view currently shown 

• Refresh – refreshes the current view 

• Fetch All - the current # of templates being shown/the # of templates in the SciCord Client 

*Options tab functions are consistent with other ‘My’ views. 

The Filters and Columns available to the User for the MyTemplates view are seen below: 
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Filters View  Columns View 

MyUsers View 
The ‘My’ View is a bookmarking functionality. The user can quickly access and manage Templates that the 

user decides to include in their MyUsers View. 

The user can go to Options tab, Bookmarks Add or, right-click on any User in the MyUsers View and an 

option to Bookmark will be available to add the selection to MyUsers view. 

The Schedule function will open a calendar view of the users Work Request schedule. All other functions are 

the same as other ‘My’ views.  

 

 

Below are the Filters and Columns available to the User to filter and display User details. 
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   Filters View     Columns View 

 

Objects and Objects View 
The Objects view implements a specific filtered and customizable view for Objects that are in the SciCord 

Solution. The Objects that appear in the Objects View are initially restricted to the User’s Site. 

 

 

Objects View shown with contextual menu options 
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Contextual menu options 

The Objects/Objects View Toolbar includes the following Icons: 



 

SciCord Client User Guide – Boron v3.0  
September 11, 2023 

 

Page 41 of 94 

 

  

 

• New – action to create a new Object 

• View – action to view a selected Object 

• Edit- action to open Object for edit 

• Clone – action to clone the selected Object 

• Review – if the user is assigned as Object reviewer, this action is enabled 

• External – opens the object external reference 

• CAS – opens the CAS registry URL 

• Status – action to modify the Object status 

• References – lists object references 

• Label -- print labels for selected objects or Objects 

• Message – send a message 

• Attachments – view attachment for selected Object or object 

The Specifications, Work Requests, Inventory, Manage, and View sections of the Home tab are consistent 

and previously covered in the MyObjects and the MyObjects view. 

Below are the Filters and Columns that may be used by the User to sort and display the Object/Object 

details 
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Filters View    Columns View 

Templates View 
The Templates View is a list of all the Templates in the SciCord System that are available to the user. The 

View will show the Status of the Template as Created, Active, Validated, or Inactive. The user can create 

multiple Templates Views and rename them as the user pleases.  
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The Templates Toolbar: 

• View (Help) – if a Help document is associated to a template this action will open the document 

• Duplicate – creates a copy of this view 

• Rename – Rename the templates view shown under the MyViews section 

• Export – export the Templates view as an excel worksheet  

• Delete – action to delete the Templates view currently shown 

• Refresh – refreshes the current view 

• Fetch All - Showing #/# - the current # of templates being shown/the # of templates in the SciCord 

Client 

Below are the Filters and Columns that the User may use to sort and display the Template details. 

   

Filters View    Columns View  
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Users View 
The Users View implements a specific filtered and customizable View of the Users that are in the SciCord 

System. 

 

Below are the toolbar functions associated with the Users View. 

  

• Schedule – action will open the selected users Work Request schedule. 

*All other sections in the Home and Options tab are consistent with MyUsers view previously discussed. 

Below are the Filters and Columns associated with the Users View. 

         

Filters View    Columns View  
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Specifications View  
The Specifications view implements a specific filtered and customizable view for Specifications that are in 

the SciCord System. The Specifications that appear in the Specifications View are initially filtered to the 

User’s Site. 

The View will show the Entity ID, Version, Name, Manual Spec ID, Description, Product Code, Status, Review 

Classification, Date and Creator of the Specification. The user can create multiple Specification Views and 

rename them as the user pleases.  

 

 

Specification’s view shown with contextual options 

  

The Home toolbar functions  

 

• New – Dialog for new specification includes, 

Name, Manual Spec ID, Product Code, Description, 

Review Classification drop list with selections for 

SelfReview, PeerReview, PeerReviewApprove. An 

Open checkbox to have the Specification open for 

edit.  
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• Clone – opens a dialog to select and clone an Object  

 

 

 

 

 

 

 

• Open – open the specification for edit has fields for:  

o Toolbar options for: Specification section - Save, New Version, Close, Refresh and Review 

Classification section with drop list option to change the review classifications. A tab with the 

Version is located above the specification name. 

o Information on the left side of the Specification view pane:  

▪ ID/Entity ID 

▪ Classification 

▪ Name 

▪ Manual Spec ID  

▪ Description 

▪ Product Code 

▪ Attachment – Upload from local file or a Data File 

▪ URL – option to Change the URL button  

▪ Notes – free text field  

 

Open Specification showing all attributes 
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*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Specifications View: 

   

Filter’s view    Columns view  
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Object Work Requests View 
The Object Work Requests view implements a specific filtered and customizable view for Work Requests 

that are in the SciCord System. The Work Requests that appear in the Work Requests View are initially 

filtered to the User’s Site. 

The View will show the Entity ID, Test Analysis, Object, Object Description, Method, Assignees, Status, 

Experiments, Comments, Scheduled From, Scheduled To, Due Days, Overdue days, Replicates, Hours 

expected, Hours spent, Date, Created By, Last Modified By. The user can create multiple Work Requests 

Views and rename them as the user pleases.  

 

 

Object Work Request View with contextual menu options 

  

The Home toolbar functions are -  

• Work Request Section –  

o View: selection will open the Work Request in read only mode 

o Delete: action will open a dialog asking if the user is sure they want to delete the selected 

work request. Button to select Yes or No.  

• Assignments Section -  

o Add: selecting a work request select Add will open a dialog to select a user to add to the 

Work Request. A checkbox is available for “Only my site” 
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o Set: action will replace a user that is assigned to a Work Request with another user by 

opening a dialog box to select a different user.  

o Clear: will reset all assignees associated to the selected Work Request 

• Object Section - 

o View: opens the object in read only mode 

o Edit: opens the object for edit 

• Document Section -  

o View: opens the document in read only mode 

o Edit: opens the document for edit  

*All other sections in the Home and Options tab are consistent with all views. 

 

Below are the default Filters and Columns associated with the Work Requests View: 

  

Filter’s view    Column’s view 
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Reports View 
The Reports view implements a specific filtered and customizable view for Reports that are in the SciCord 

System. The Reports that appear in the Reports View are initially filtered to the User’s Site. 

 

 

Report’s view 

 

    

The Home toolbar shows:  

• Reports section: 

o Manage Reports - opens the SciCord Portal Reports Index 

o Details: opens the SciCord Portal Report Details page of the selected report 

o Launch: opens the SciCord Portal report configuration page and a Show button. 

*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Reports View: 
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Filter’s view   Column’s view  

 

 

Object Inventory Requests View 
The Object Inventory Requests view implements a specific filtered and customizable view for Object 

Inventory Requests that are in the SciCord System. The Object Inventory Requests that appear in the Object 

Inventory Requests View are initially filtered by Status. 

 

Object Inventory Request view shown with contextual menu options 
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 The Home tab options are:  

• Inventory section –  

o View – opens a dialog to show the request details 

o Inventory – opens the Object inventory requests page 

o Schedule – opens calendar view of the Object inventory requests 

o Label – opens the print labels dialog, options to select Label Size, create Custom Sequence, 

Print or Close 

 

 

 

 

 

 

 

 

 

 

 

 

• Object section – Edit or View the object inventory request 

*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Object Inventory Request View: 
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Filter’s view   Column’s view  

Object Results View 
The Object Results View implements a specific filtered and customizable view for Object Results View that 

are in the SciCord System. The Object Results View that appear in the Object Results View are initially 

filtered by the user’s site and Only Pending. 

 

 

Object Results view shown with contextual menu options 
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The Home toolbar options are:  

• Object section:  

o Edit Object – if object is not in ‘Available’ status, user can edit the object 

o View Object – opens the object in read only mode 

• Document section: 

o Edit Document – if document is not in ‘Complete’ or ‘Cancelled’ status, user will be able to 

edit the document 

o View Document – opens the document in read only mode 

*All other sections in the Home and Options tab are consistent with all views. 

Below are the default Filters and Columns associated with the Object Results View: 

  

      Filter’s view            Column’s view  
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Specifications  

Functions 
A user is able manage Object specifications if they have the Object_Edit permission. There are sliding panes 

available to expand your views of the specification.  

The user can create a specification, add objects to the specification, create rules, create versions, view 

Object results, show the history of the specification, and all signatures associated. An export of all the data 

to an Excel spreadsheet is also available.  

 

The Home toolbar functions are shown below:  

Specification:  

 

• New – Dialog for new specification includes, Name, 

Manual Spec ID, Product Code, Description, Review 

Classification drop list with selections for SelfReview, 

PeerReview, PeerReviewApprove. An Open checkbox to 

have the Specification open for edit.  

• Clone – opens a dialog to select an Object to clone 

 

 

 

 

 

 

• Open – open the specification for edit has fields for:  

o Toolbar options for: Specification section - Save, New Version, 

Close, Refresh and Review Classification section with drop list option to change the review 

classifications. A tab with the Version is located above the specification name. 

o Information on the left side of the Specification view pane:  

▪ ID/Entity ID 

▪ Classification 

▪ Name 

▪ Manual Spec ID  

▪ Description 

▪ Product Code 

New Specification dialog 

Clone sample dialog 
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▪ Attachment – Upload from local file or a Data File 

▪ URL – option to Change the URL button  

▪ Notes – free text field  

 

Shown here is a Created Specification for edit  

o Information on the right side of the Specification view pane:  

▪ Tabs for Rules, Objects, History, and Signatures 

Rules 
Create a Specification Rule dialog:  
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• Measurement – selecting the “…” will open a Select 

Measurement dialog. These measurements are set up in the 

SciCord Portal Laboratory Configurations 

• Rule Name is automatically populated once the 

Measurement is selected.  

• Report Label – free text 

• Display Order – numeric values to assign order 

• Method - selecting the “…” will open a Select Resource 

dialog. The methods used are created from resource 

documents in the Client. 

• Verify only results matching attributes – checkbox to 

activate attributes set in the SciCord Portal Laboratory Configurations 

• Comments - selecting the “…” will open a dialog to expand the comments box 

• Rule Type – Numeric or Text 

If Numeric Rule Type is selected:  

o Checked against – drop list values set in the SciCord Portal Laboratory Configurations 

o Number of decimal places 

o Criteria Error – drop list selection of “≤” or “<” and a text box display to 2 decimal places 

o Criteria Warn - drop list selection of “≤” or “<” and a text box display to 2 decimal places 

o Criteria Warn - drop list selection of “≥” or “>” and a text box display to 2 decimal places 

o Criteria Error - drop list selection of “≥” or “>” and a text box display to 2 decimal places 

• If Text Rule Type is selected:  

o Checked against - drop list values set in the SciCord Portal Laboratory Configurations 

o Criteria Expected values – selecting the “…” will open a dialog to expand the text box 

o Acceptance values - selecting the “…” will open a dialog to expand the text box 

• Data input instructions – checkbox to activate for Measurements with Instruction Label Attributes 

defined in the SciCord Portal Laboratory Configurations. Selecting the “…” will open a dialog to expand 

the text box 

Buttons to Create and Continue, Create, and Cancel. Once the Specification is created      
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Specification Rule shown with contextual menu and all available columns and data. 

Once a specification has been created the available buttons are:  

• Create- create a rule dialog opens 

• Create from – copies a rule from a selected rule and opens the dialog to create it  

• Edit  

• Delete 

• Disable/Enable – toggles the flag to enable or disable a specification 

• View – opens for view  

Objects  
The Objects tab is available to Add, Remove, Edit, and View the Objects for the specification. The user may 

use the toolbar options or the contextual menu options to complete these tasks.  
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To ‘Add’ Objects to a specification:  

✓ Select Add button 

✓ Select Objects dialog opens 

  

✓ Select Object(s), using Filters if needed to Add To Selection Queue.  
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✓ Click OK, the Specification Objects tab is updated to show the object selected  

To Remove the Object from the Specification 

✓ Select the Object 

✓ Click Remove 

✓ A message appears asking if you are sure you want to 

remove the selected Objects, click Yes or No 

✓ The Object has been removed 

 

To Edit the Object associated to the Specification 

✓ Select the Object 

✓ Click Edit 

✓ Dialog opens showing the Object Properties, toolbar options  

 

 

Object Properties Home tab shown with toolbar options 

             Object Properties Tools tab with subpanel toggle to reveal subpanel options – Info, Aliquots, 
References, History, Signatures, Attachments, Family 
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To use the View button, this action will reveal the Object Properties shown with yellow ribbon to designate 

the user is viewing in Read Only View 

 

History 
The Specification History tab has checkboxes for System, Specification, and Rules. These checkboxes filter 

the Target Column data. Columns for Date, Author, Target, Event Type, Property, Value, Previous Value, 

AuditID 
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Signatures 
This Signatures tab will display all signatures associated with the Specification. There are columns to show 

Signature Date, Created By, Signature Type, and Signature Meaning. 

 

Specification signatures show the time and date of the signature, the user id of the Reviewer and the Approver. 

Create New Version  
Using the New Version button in the toolbar will create a copy of the previous version. The user can then go 

in and manage any updates or changes needed.  

 

Version 2 of the Specification is denoted in a blue tab located under the New Version button 
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Document Editor 
A User is able open any Document for Edit if they have the Document_Edit permission. After a Document 

has been edited and closed an electronic signature will be required. 

Functions 
Document Editor Functions appear when the User opens a Document for Edit or Review, however only 

changes that are made to a Document in Edit mode will be saved. Many of the functions in the toolbar are 

like functions in Excel and Word. Below are images of the Document Editor Toolbar. 

*See the SciCord Icons and Meanings section for a description of each of the icons. 

 

Documents View Home tab  

 

Document editor Home tab 

 

Document editor Insert tab 
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Document editor Format tab 

 

Document editor Review tab 

 

Document editor Tools tab 

 

Create a Document 

To create a Document: 

✓ select the New Document icon (  ) in the system toolbar or in a (My)Documents View 

✓ A New Document dialogue will appear.  

✓ The New Document dialogue provides buttons for a view of either ‘All Templates’ or ‘My 

Templates’ 

✓ Filter bar can be dynamically filtered by recording text 

✓ Select a template from the list 

✓ Attributes, Directories, Tags, Groups can be added to the document. These add additional 

filters for the document being created. 
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✓ Record a Description for the selected Template 

✓ Set the Review Classification (SelfReview, PeerReview, PeerReviewApprove).  

✓ Open Document checkbox is checked by default. This will automatically open the user 

document 

✓ After ‘OK’ is selected the document will be opened if the ‘Open Document’ flag is selected. 

 

 

Read Only Mode document  

Note: When a Document is opened for Read-only the Document will open with a yellow ribbon (as seen on 

the image above). This denotes that the Document is in Read-only mode and no changes will be saved. 
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Documents View Subpanels 
 

 

Subpanels can be accessed by pulling up on the gray bar “…..” at the bottom of the client interface.  

All Documents in the SciCord Client have Subpanels; however, each subpanel varies depending on the 

structure of the Template and whether there is any instrument interfacing. Some basic features include:  

 

 

Subpanel – Info tab 
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Subpanel – Aliquot’s tab 

 

Subpanel – Attributes tab 

 

Subpanel – Barcode Tool 

 

Subpanel – Data tab  
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Subpanel – History tab 

 

 

Subpanel – Notes tab 

 

 

Subpanel – Objects tab 
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Subpanel – References finder 

 

Subpanel – Review Alerts tab 

 

Subpanel – Signatures tab 
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Subpanel – Work Request tab 

 

 

Subpanel – Instruments tab 

 

Subpanel – Camera tab

 

Subpanel – Attachment’s tab 
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Additional panels may be present such as Training Assignments or Moisture Interface depending on context. 

• Info: Displays information such as the document’s description, original template, author, review 

class, status, etc. 

• Aliquots: The user can review the Aliquots (Objects) that have been associated with the Document. 

• Attributes: Metadata, configured by the Template Developer, that is stored by the document and 

viewable to the user. Such metadata may also be used for reporting purposes. 

• Barcode Tool: The user may record a resource into the Document by using the Barcode Tool 

• Data: The Data tab lists all the Data from the Document that is being extracted. The Data includes 

Aliquots, Test (Analyses), Method, Method Version, Measurement, Value and Raw Value, the Unit, 

and configurable Attributes 1-5. 

• History: The user can view the history of any cell, worksheet, or workbook. Record of all dates and 

times of any document creation or modifications.  

• Notes: Allows a user to make Notes/Comments in any cell of the document. The user may create 

new Notes or Append old Notes. Each Note contains data on who it was Created By, the Date, the 

Note Text and Note Location. Once the document is in Complete status, the notes will disappear. 

• Objects: The user can review the Objects that have been associated with the Document. 

• References finder: Allows a user to search for objects and record references to them in the current 

document. 

• Review Alerts: The user may view Review Alerts that are associated with the document. This 

function could lead a reviewer to potential issues with a document. 

• Signatures: Each electronic signature that is conducted within the document is listed; the Date, 

Signee, Signature Type and Meaning are recorded. 

• Work Requests: Allows a user to review work requests associated with the current document 

• Instruments: The user can connect to an instrument that is recorded in the Document, retrieve 

readings from the instrument and view the Calibration Due Date, instruments last check date and 

the outcome. 

• Camera: The user can interface with their PC’s camera to capture/record pictures to the document 

in real-time. 

• Attachments: This dialogue screen shows any item that is attached in the document. It provides 

details on the Description, Date recorded, Created By which User, and Source File. 

Other Items that can be included in the Subpanel include: 

• FD10 Interface, Raman Interface, GeoPyc Interface, Sympatec Interface, DVS Interface, Analyst 

Interface, and Usage Log 

Structured Data 
Structured Data is available and can be configured based on customer specific business logic. Structured 

Data consists of System Configuration information, such as Lists, Data extracted from Documents in the form 

of Analysis and Component Results, and Document Attributes in the form of ConfigAttribute Results.  
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Object Editor 

Properties 
A user must have the Object_Edit permission to Open an Object for Edit and the Object must be in either 

Created or In Progress/Rework Requested Status. A User may not Edit an Object that is in Cancelled, Review, 

Approve or Available Status. The Object Edit view opens onto the Objects Properties tab. On the Left Panel 

of the Object Properties are the Mandatory Object Attributes that are configured using the SciCord Portal. 

The Right Panel contains Object Properties that are Optional and configured using the SciCord Portal. Only 

the Attributes on the Right Panel can be Edited after the Object has been Created.  

Below are examples of Attributes that can be configured in the Portal as either Mandatory or Optional. 

 

Object Work Requests 
A user with the Object_Edit permission may ‘Add’ Work Requests to an Object. Work Requests are 

configurable using the SciCord Portal and a Method, Location, and Comment may be associated with each 

individual Work Request. The right-hand pane of the Work Requests interface provides a table for 

associated Aliquots, representing testing performed for a specific Object and Analysis. The user may select 

and View the Document. 
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The Subpanel shows the User the Attachments, Aliquots, History, Comments, and Signatures tabs. 

Object Results 
The Object Editor provides a Results tab that is a view of the Structured Results/Data as related to the 

current Aliquot. An ‘Export’ function allows the User to save the listed results as an Excel (.xlsx) or Comma 

Separated Values (.csv) File on their machine. 

 

Objects Subpanel 
In the Object Editor, the Subpanel shows the User the Attachments, Aliquots, History, Signatures, 

Attachments, and Family tabs of the selected Object.  

 

Attachments 
A User may browse Attachments and Add Attachments up to 20MBs. Attachments may also be added to the 

Object from DataFiles. The User may Append the Attachment Description by typing into the Append bar and 

then selecting ‘Append’. Although a User may Remove an Attachment, they can also easily Restore an 

attachment by ‘Include Removed’, selecting the Removed Attachment, and then selecting the 

‘Remove/Restore’ button. 
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Aliquots 
Aliquots are instances where a parent Object is introduced into a Document. Each single association 

between an Object and a Document will represent a unique Aliquot ID. The User may either View or Edit the 

Document that the Aliquot is associated with by selecting the View/Edit buttons. 
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History 
The History tab provides visibility and partial management of auditable events performed on an Object. In 

an Object Open for Edit a User can select events from the History table and append a reason via the 

‘AddToReason’ button which will appear in the Reason column of the table. 
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Signatures 
The Object Editor supports Digital Signatures for Author(s) and Reviewer(s). The Signatures tab displays all 

Signatures applied to an Object, including final Approval signatures of Objects with ‘PeerReviewApprove’ 

classification and ‘Complete’ status. The user may also select a pending signature by a user as Author or 

Reviewer and sign by providing the proper password and meaning. 
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Attachments 
The Attachments tab permits a user to link attachments or DataFiles to the current object. The attachments 

tab displays all attachments and DataFiles that have been linked to the object, including the Object ID and 

Description, Date of attachment linkage, Created By, and Source File name. The user may also remove 

previously linked attachments, and filter the view to include removed attachments. 
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Family 
The Family tab provides a comprehensive view of the object hierarchy and the relationships between parent 

samples, child samples, and subsamples. Within the Family tab, you'll find valuable information such as 

Entity IDs, Sub Object status, Descriptions, Expiration and Calibration Dates, Current Amounts, and 

Locations. The parent sample takes precedence, appearing at the top level (in the first row), followed by its 

associated child samples. 

 

Object Inventory 
The SciCord Solution supports Objects Inventory management and custody tracking across Objects family. 

Inventory transactions can be booked and planned through previously entered inventory requests. The 

Objects Family is defined through the Parent-Object relationship. An Object may have multiple children and 

each child may have other children as well. 

A user must have the ObjectInventory_Edit, ObjectInventory_View, ObjectInventoryRequest_Edit, or 

ObjectInventoryRequest_View permission to be able to open the ObjectInventory view. Depending on the 

permission granted the user will be able to edit or view the Inventory Requests and Inventory Transactions. 

A user with any of the above-mentioned permissions will be able to export all Inventory Requests for all the 

Objects as an Excel or CSV file. A user with the ObjectInventory_Edit or ObjectInventory_View permission 

may export all Inventory Transactions as an Excel or CSV file. 



 

SciCord Client User Guide – Boron v3.0  
September 11, 2023 

 

Page 79 of 94 

There are a couple of ways to access the Object Inventory: 1) From a ‘Objects’ or ‘MyObjects’ View, the user 

may select an Object, and in the Object Toolbar, click the ‘Open the Object Inventory’ button  ; 2) If an 

Object is opened in either Edit or Read Only Mode, the user may click the ‘Open the Object Inventory’ 

button in the toolbar . 

 

Inventory Transactions 
Inventory Transactions are used to record actual movements from or into the Inventory. The Transaction 

can either be recorded from scratch or created following a previous Inventory Request (see Inventory 

Requests). In the latter case, the system will keep the link between the Request and the Transaction. To 

create Inventory Transactions a User must have the ObjectInventory_Edit permission.  

 



 

SciCord Client User Guide – Boron v3.0  
September 11, 2023 

 

Page 80 of 94 

A user may set the Transaction Date, set an 

Event (Pick, Return, Fill, TransferIn, 

TransferOut, Disposal), set an Amount to be 

removed or added to the current amount, 

record an Analyst the amount was 

dispensed to or returned from, record any 

Comments or any Attachments. With each 

transaction the SciCord System will 

automatically record the user who recorded 

the data, local time, and system timestamp. 

 

 

A user may also Transfer material between 

Objects. A user with the ObjectInventory_Edit 

permission may conduct a Transfer. A Transfer 

will generate two transactions: one removing 

material from the Source and the other adding 

material to the selected ‘Transfer to’ Object. 

 

The Transactions may be exported as either an Excel file (.xlsx) or as a CSV (.csv) file. 

 

Inventory Requests 
Inventory Requests are made by users, to request a quantity of a particular Object or to book a restitution. 

Inventory Requests track only the request of the material, while the actual movement from or into the 

inventory will be recorded by creating corresponding Inventory Transactions. Only the User with the 

ObjectInventory_Edit or ObjectInventoryRequest_Edit are able to create Inventory Requests and 

mark/unmark existing requests as ‘Complete.  
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When creating a Request a user may set a Due Date, select an Event (Pick/Return), set an amount to be 

added (Pick) or removed (Return), make a comment, or record an attachment. As each Request is completed 

the SciCord Solution will automatically record the user who made the request, the local time/system 

timestamp, and allows a User to send notification of the Created Request to the interested parties. The 

Requests may be exported as either an Excel file (.xlsx) or as a CSV (.csv) file. 

 

Document and Object Life Cycle 
The SciCord Solution provides Document and Object Management capabilities for SciCord generated 

Documents and Objects. Document and Object management includes support for authenticated electronic 

signatures and controlling the review and approval processes. 

Document Life Cycle 

The Life Cycle (Workflow) is determined by the user at the creation of the Document by selecting a Review 

Classification from the drop-list, however, the workflow may be changed afterwards by selecting the 

Document and then selecting the ‘Modify Status’ in the Documents or MyDocuments toolbar. Only a user 

with one of the Document_ReviewClassUpdate permissions is allowed to modify the Document workflow. 

 

 

Review Classifications  
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Below is an example of each Document Workflow (Review Classification) 

 

 

Object Life Cycle 

As part of the Object Type configuration, the Object Type will have a default Review Classification 

(Workflow) upon creation. This Workflow may be changed only by a user with one of the 

Object_ReviewClassUpdate permissions. To do so, the User would have to select the Objects in the 

Object/MyObject View and then select the ‘Modify Status’ button in the toolbar. From the Object Status 

dialogue, the user will be able to modify the workflow. 

 

Below is an example of each Object Workflow (Review Classification) 
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Electronic Signatures 
The Document/Object Editor supports in-line management of digital Signatures for Author(s), Reviewer(s). A 

Signatures tab in the subpanel displays all signatures applied to the Document, including final Approval 

signatures of Documents with ‘PeerReviewApprove’ classification and ‘Complete’ status. 

 

Self-Review 
The Self Review workflow process includes the Document or Object Creation, InProgress, and Complete 

phase. A Document or Object may also be Cancelled or a Rework Requested. An Object may be set to 

‘Available’  

By selecting ‘Set Status’ besides ‘Complete’, or any of the phases (if available) the Document will be in 

Complete Status. 
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Below are images of the Workflow for a SelfReview Document and Object. 

 

 

Self-Review Document          Self-Review Object 

  

*Note: Objects include an ‘Available’ phase in their Life Cycle. 

 

Peer Review 
The Peer Review workflow process includes the Document or Object creation, InProgress, Review 

(ReviewAssigned), and Completion. A user may also choose to set the Document or Object to Cancelled, or 

have the Document or Object be Reworked (ReworkRequested). 

If the user were to select the ‘Set Status’ icon besides the Cancelled text, the Document will be in a 

Cancelled state. If the user would select the ‘Reviewer’ then the user would be able to select from a 

dialogue box, the Reviewer who would Review the Document. 
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Below are images of the Workflow for a Peer Review Document and Object. 

  

Object in Review Mode  



 

SciCord Client User Guide – Boron v3.0  
September 11, 2023 

 

Page 86 of 94 

 

Document in Review Mode 

When a Reviewer opens a Document for Review, they will notice symbols within the Document related to 

their Review.  

   - The visible entry in the cell is the initial entry. 

   - The visible entry in the cell is not the initial entry and the history of the cell should be reviewed        

using the History subpanel. 

The Review may also view the subpanel Review Alerts tab, which highlights events requiring attention for 

the current Document. Examples of Review alerts are: Unlocking a cell, Balance not stable at time of 

recording, Balance not checked on day of usage, Instrument Calibration past due date at time of recording, 

or Document Template not validated at time of Document Creation. 

 

Peer Review Approve 
The typical PeerReviewApprove workflow process for a Document or Object would include the Document or 

Object creation, InProgress phase, ReviewAssigned, and ApproveAssigned. At any point a User may Cancel 

or assign the Document or Object to ReworkRequested. 

The green depicts which stage of the workflow process (Reviewed) that the Document or Object (Rework 

Requested) is on. In this example the Document is in the ApproveAssigned phase of the workflow process.  
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Below are images of the PeerReviewApprove workflow for a Document and Object. 

  

Document in PeerReviewApprove   Object in PeerReviewApprove 

 

 

Document Review 

Documents that are assigned to the user for review may easily be viewed in the MyReview View. The default 

filtering of this View is Status: ReviewAssigned and Reviewer: the user’s name. If there is a need, the user 

may change these default settings to include other users as well.  

From the MyReview view the user can select a Document and then click on the ‘Open Document for 

Review’, , icon. After selecting the icon, the Document will open and be able to be Reviewed. Also, the 

User may view either the Documents or MyDocuments view and, looking at the icon column, determine 

whether a Document is in Review status by observing the ‘Open Document for Review’ icon. If the 

Document is in Review status, only the user who has been assigned to Review will be allowed to access the 

Document for Review. 
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SciCord Icons and their Meanings 
 

SciCord 
Icon 

SciCord Icon Meaning 

 
Create a Document 

 

 
Open Document for View/Read Only Mode 

 
Open Document for Edit 

 
Clone a Document 

 
Clone a view 

 
Review a Document 

 
Modify Document Status 

 
The Review Classification is set to Approve Assigned 

 
The Review Classification is set to Review Assigned 

 
Document is In Progress 

 
The Document is Cancelled 

 
Rework Requested Document 

 
The Document is Complete 

 
Unlock a Document/Object 

 
The Document/Object is locked 

 
Refresh the SciCord Client 

 
Export View or Save this Document as a Local Excel File 

 
Bookmark - Add to My “x” View, where x is any view 

 
Bookmark - Remove from My “x” View, where x can be any view 



 

SciCord Client User Guide – Boron v3.0  
September 11, 2023 

 

Page 89 of 94 

 
Add to Groups 

 
Remove from Groups 

 
Message Alert 
 

 
New Message 

 
Read Message 

 
Dismiss Message 

 
Create an Object 

 
View Object 

 
Edit Object 

 
Clone Object 

 
Review Object 

 
Modify Object Status 

 
Object Status is In Progress 

 
Object Status is Available 

 
Object Status is Cancelled 

 
Object Status is Rework Requested 

 
Object Status is Review Assigned 

 
Object Status is Approve Assigned 

 
Object Status is Complete 

 
Print Labels for Selected Objects 

 
Open Object Inventory 

 
Open Inventory Calendar 

 
View Object Work Requests 

 
Delete Object Work Requests 
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Close and Save Changes 

 
Open the Object Work Request Calendar 

 
Open Object Specifications 

 
Add Object Specification 

 
Clone Object Specification 

 
Close View 

 
Move a View in the View pane up  

 
Move a View in the View pane down 

 
Create or Add a new navigation view  

 
Home Dashboard 

 
Bulk Remove views 

 
Delete View 

 
Rename a View/Document/Object 

 

Add Tags 

 

Remove Tags 

 
Set Tags 

 
Documents View 

 
MyDocuments View 

 
Objects View 

 
MyObjects View 

 
Data Files View 

 
MyDataFiles View 

 
Groups View 
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Inventory Requests View 

 
Messages View 

 
Resources View 

 
MyResources View 

 
Reports View 

 
MyReports View 

 
Results View 

 
Sent Messages 

 
Specifications View 

 
Work Requests View 

 
Templates View 

 
MyTemplates View 

 
User View 

 
MyUsers View 

 
MyApprove View 

 
MyReview View 

 
Download files 

 
Upload files 

 
Delete Data File 

 
Data File History 

 
Settings 

 
Open SciCord Portal 

 
Open Resource Read Only 
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Open Resource for Edit 

 
Print Labels for Selected Resource 

 
Open Resource Inventory 

 
Resource in Review Status 

 
Resource Status is Complete 

 
Resource Status is Cancelled 

 
Help  

 
Login 

 
Logout 

 
Save 

 
Search 

 
Reorder Worksheets 

 
Toggle Worksheet Headers 

 
Show Gridlines 

 
Names Manager 

 
Copy  

 
Paste 

 
Symbols 

 
Insert Signature 

 
Insert File Attachment 

 
Create New Worksheet 

 
Import from a Workbook 

 
Insert Textbox 

 
Insert Line 
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Insert Image 

 
Insert Chart 

 
Insert Date 

 
Insert Analyst 

 
Insert Note 

 
Bold 

 
Italicize 

 
Underline 

 
Left Justify 

 
Center Justify 

 
Right Justify 

 
Text Color 

 
Word Wrap 

 
Cell Fill color 

 
Cell Border 

 
Cell Format 

 
Shrink Columns 

 
Expand Columns 

 
Shrink Row 

 
Expand Row 

 
Review Marks 

 
Change Marks 

 
Toggle Subpanel 

 
Barcode Scanner 
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Open URL 

 
Switch User 

 
Scheduling 

 
Hide 

 
Manage Reports 

 
View Report Details 

 
Launch Report 

 
Redo 

 
Settings 
 

 
Columns   

 
Filters  

 
Close Current Page 

^ Expand or Collapse Tools Panel 

 
Review Selection– provides the Reviewer the ability to ‘Review’ each cell in a 
worksheet individually. By selecting the icon, the Review symbol will be 
removed. 

 
Review Worksheet– provides the Reviewer the ability to ‘Review’ each 
worksheet in totality. By selecting the icon, the Review symbols will be 
removed from the worksheet. 

 
‘Mark Document as Reviewed’ – provides the Reviewer the ability to ‘Review’ 
the workbook in totality. By selecting the icon, the Review symbols will be 
removed from all areas of the workbook. 

 

Duplicate – Creates a copy of the current view 

 

Add Directory 

 

 


